
Рассмотрим обработку данных численного моделирования, полученных в среде 

Ansys Fluent. Обработку данных будем рассматривать в модуле постобработки CFD-Post 

(Results). В данной лекции будет рассмотрена обработка данных на примере нескольких 

задач.  

Первая задача – обработка полей скорости и температуры в теплообменнике вида, 

труба в трубе. Схема теплообменника представлена на рисунке 1. Геометрию задачи 

можно разделить на четыре части. Область внутри трубы малого диаметра, в которой 

течет воздух, стенки трубы малого диаметра, область между трубками, по которой течёт 

вода и стенки внешней трубы. В таблице 1. представлены размеры теплообменника.  

  

 
Рисунок 1. Расчётная схема теплообменного аппарата 

 

Таблица 1 
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После запуска постобработчика откроется окно. Слева расположено дерево проекта, 

справа – окно визуализации.  

В ветке FLU располагаются все четыре домена геометрии: part inner – внутренняя 

трубка, part outer – внешняя трубка, part water_cold, part water_hot – холодный и горячий 

теплоносители. Если раскрыть каждую из четырёх подветок, то можно увидеть список 

границ каждой области. 

Ниже находится ветка User Location and Plots – в этой ветке добавляются 

линии/плоскости/поля и другие геометрические элементы, созданные пользователем. 



Default transform – позволяет настроить особенности отображения геометрии (например 

зеркально отразить, переместить и т.п.). 

Галочки напротив Default Legend View 1 и Wireframe. Позволяют отобразить в окне 

визуализации легенду и границы геометрии. На рисунке 2 отображаются только 

торцевые границы  геометрии.  

В ветке Report – отображаются графики и таблицы пользователя. Chart и Table, 

соответственно. 

 

Рисунок 2. Внешний вид постобработчика CFD Post 

Для визуализации полей или профилей рассчитанных величин необходимо добавить 

плоскости и линии, на которых будут строиться поля и профили: правая кнопка мыши по 

User Location and Plots → Insert → Location → Plane/Line и т.п.  

 

Рисунок 3. Добавление локаций пользователя 



Далее вводим имя плоскости или линии. 

 

Рисунок 4. Создание плоскости 

После введения названия локации пользователя появится панель с настройками 

данной локации – Details of «Имя локации». Для построения плоскости выбираем метод 

построения XY Plane. По координате Z необходимо ввести расстояние, на котором будет 

построена плоскость. При установке курсора в поле ввода, снизу поля появится бегунок, 

ограничивающий координаты, в которых может быть построена плоскость. На рисунке 

ниже представлена построенная плоскость, через все домены: Domains →All Domains. 

 

Рисунок 5. Пример созданной плоскости 

Так же меняя Domain, можно провести плоскость через отдельную часть составной 

геометрии. На рисунке ниже построена плоскость только через внутреннюю жидкостную 

часть. 



 

Рисунок 6. Плоскость, проходящая только по внутренней трубке 

4. Далее на созданную плоскость можно нанести поле какой-либо рассчитанной 

величины. User Location and Plots → Insert → Contour.  

 

Рисунок 7. Вставка поля (контура) переменной в дерево проекта 

Details of «Contour1»/Location выбираем ранее созданную плоскость или границу. В 

Variable выбираем интересующую нас переменную, например температуру. В Range 

можно установить диапазон значений, в котором будет построен контур. # of Contours – 

количество цветовых спектров, которые будут отображаться на легенде.  



 

Рисунок 8. Выбор локации для построения поля переменной 

 

Рисунок 9. Поле температуры (построено с параметрами по умолчанию) 

5. Для того чтобы на легенде температура отображалась в градусах Цельсия, 

необходимо настроить единицы измерения в постобработчике: Edit → Options → Units. 



 

Рисунок 10. Настройка системы единиц 

6. Аналогичным способом можно построить поле температур на продольной 

плоскости. Для отображения контура на нескольких плоскостях, необходимо нажать 

кнопку … , расположенную справа от выпадающего списка. Откроется список всех 

доступных локаций, в котором через зажатый Ctrl  можно выбрать одновременно 

несколько плоскостей.  

 

Рисунок 11. Поле температуры на нескольких плоскостях 

Опция #of Contours позволяет настроить гладкость цветовых переходов на 

отображаемом поле. Чем больше число #of Contours, тем более гладким выглядит поле. 

 



Важно! 

Числовые значения на легенде соответствующие определённому цвету, говорят о 

диапазоне значений переменной, а не о конкретном её значении. Так, например, на 

рисунке 11 тёмносинему цвету поля соответствует температурный диапазон от 19,98 до 

24 
0
С, а не конкретное значение температуры равное 19.98 

0
С.  

Для настройки и отображения легенды поля, можно воспользоваться веткой дерева 

Default Legend View 1. 

 

Рисунок 12. Настройка легенды 

Галочка слева от Default Legend View 1 включает/выключает отображение легенды 

рядом с контуром. 

В Details of Default Legend View 1 находится две вкладки Definiton и Appearance. 

В первой вкладке в Title Mode можно выбрать тип заголовка легенды. Доступно 

четыре варианта: 

1. No title – легенда без заголовка. 

2. Variable – будет отображаться только имя переменной. 

3. Variable and Location (по умолчанию) – отображается имя переменной и название 

локации, на которой построено поле. 

4. User Specified – заголовок пользователя. 



Чекбокс Show Legend Units – включает/выключает отображение единиц измерения 

переменной. 

Радиобаттоны Vertical/Horisontal определяют направление, по которому располагаются 

цвета легенды: слева направо или сверху вниз. 

В пункте Location можно выбрать типы выравнивания легенды по вертикали и 

горизонтали. X Justification – доступны выравнивания по левому/правому краю и центру, 

Y Justification – выравнивания по верхнему/нижнему краю и центру. Если выбрать тип 

выравнивания None, то снизу в пункте Position станут доступны для ввода координаты 

положения легенды. На рисунке 13 показан пример отображения легенды поля с 

отключенным отображением единиц измерения, с выравниванием по горизонтали по 

центру и с горизонтальным направлением. 

 

Рисунок 13. Пример отображения легенды горизонтальной направленности, выровненной по 

центру 

Во второй вкладке Appearance можно настроить размер легенды, шрифт, тип числовых 

данных и т.д. (рис. 14) 

Sizing parameter – Size и Aspect позволяют задать размер легенды и отношение сторон 

цветовой шкалы. На рисунке 15 представлена легенда с увеличенным размером, по 

сравнению с рисунком 13, до 0.7 и аспектом 0.1  

 



 

Рисунок 14. Вкладка Appearance для настройки легенды 

 

Рисунок 15. Пример изменения настроек размеров легенды 

Опции Text Parameters позволяют поменять настройки шрифта легенды. 

Счётчик Precision – настраивает количество значащих  цифр в легенде. Scientific– 

научный тип представления численных значений (по умолчанию) и Fixed – представляет 

значения в легенде в вещественном формате. 

Font – выбор шрифта, Color Mode и Colour – цвет шрифта легенды. Text Rotation – 

настраивает поворот текста, Text Height – высота текста. На рисунке 16 представлена 



легенда с изменёнными текстовыми параметрами: количество символов после запятой – 

0, фиксированный формат отображения, красный цвет, поворот текста – 45 градусов, 

высота 0.02. 

 

Рисунок 16. Отображение легенды с изменёнными настройками шрифта 

В пункте меню Edit / Options или из контекстного меню экрана Viewer Options… можно 

задать дополнительные параметры отображения: цвет экрана, отображение осей и 

логотипа Ansys. Для данных настроек нужно перейти во вкладку Viewer.  

В Background: Mode – определяет цвет фона или фоновое изображение. В Color Type 

настраивается сплошной цвет фона или градиент. При выбранном градиенте нужно 

задать два цвета. Если задать один и тот же цвет, то будет сплошная одноцветная 

заливка. 

Ansys Logo – настраивает отображении логотипа. 

Чекбоксы Axis Visibility и Ruler Visibility включает/отключает отображение осей 

координат и масштабной линейки. 

 

  

 



 

Рисунок 17. Вкладка Viewer окна Options 

 

Рисунок 18. Результат отображения поля температуры с изменённым фоном и отключенным 

логотипом. 

7. Как было указано выше отображение полей величин, показывает диапазоны величин 

отображаемой переменной. По полям величин можно судить о качественной картине 

течения. Для определения количественных характеристик лучше всего воспользоваться 

представлением величин в виде профилей на графиках.  

Для построения профилей величин сначала необходимо построить линии, по которым 

будет строиться профиль. В настройках линии необходимо ввести координаты x,y,z для 

начальной и конечной точек. В Samples необходимо задать количество промежуточных 

точек, по которым будет откладываться на графике интересующая величина. 

Максимальное количество – 1000. Если будет задано малое количество промежуточных 

точек, то итоговый профиль может получиться ломанным. 



 

Рисунок 19. Построение линии, по которой будет отображаться профиль температуры 

8. После построения линий необходимо добавить систему координат, в которых 

будет построен график. Results → Insert → Chart.  

 

Рисунок 20. 

9. Во вкладке Data Series создаётся серия данных, которые будут нанесены на 

график. Кнопками  можно добавлять и удалять серии данных. В Location каждой 

серии данных присваивается линия, по которой будет построен график. В данном случае 

Line 1. 



 

Рисунок 21. 

Во вкладке X Axis выбирается переменная, которая будет служить аргументом на 

графике. В данном примере будет строиться распределение температуры вдоль оси 

трубки, поэтому выбираем Variable - Z. 

 

Рисунок 22. 

Во вкладке Y Axis выбирается зависимая переменная, в данном случае температура. 

Далее нажимаем Apply. В Chart будет построен график изменения температуры вдоль 

оси центральной трубки.  



 

Рисунок 23. Пример отображения переменной поля на графике 

На рисунке ниже представлено распределение температуры по середине кольцевого 

канала. (Были изменены координаты Y у Line 1). 

 

 

Рисунок 24. 

10. Данные с Chart можно экспортировать для обработки в стороннем обработчике 

графиков, на пример в SciDaVis. Export → далее вводим имя и местоположения файла, в 

который осуществляется экспорт, обязательно и название и путь в английской раскладке. 

Выбираем тип файла csv или dat.  



 

Рисунок 25. Экспорт данных с графика во внешний файл 

Так же можно настроить отображение профилей стандартными средствами CFD 

Post. В настройках осей можно настроить в пункте Axis Range диапазон значений на оси, 

если выбран чекбокс Determine ranges automatically (по умолчанию), то на графике 

отобразится диапазон от минимального до максимального значения переменной. Если 

данный чекбокс выключить, то станут доступны для редактирования пол Min и Max. В 

чекбоксах ниже можно настроить логарифмический масштаб на оси и инвертировать 

значения на оси. 

В пункте Axis Number Formatting можно настроить отображение числовых значений 

на осях: если выключить чекбокс автоматического определения формата числовых 

значений, то можно будет настроить количество значащих символов и выбрать научный 

или фиксированный формат отображения  числовых значений. 

Пункт Axis Labels позволяет настроить заголовок оси. Если выключить чекбокс в 

данном пункте, то активируется поля ввода для пользовательского названия оси. 

Во вкладке Line Display можно настроить отображение линий на графике, легенду и 

т.д. В окне Specify the properties of each line можно через чекбокс включать/выключать 

отображение линии на графике. 

Чекбокс Use series name for legend name позволяет использовать название серии 

данных (из вкладки Data Series) в качестве подписи к линии. Если его выключить можно 

будет задать пользовательскую подпись линии. 

Line Style – определяет тип линии: сплошная, пунктирная и т.п. 



Чекбокс Automatically generate Line Color позволяет настроить цвет линии. Если 

выключить чекбокс, появится возможность выбрать цвет линии вручную. 

Line Type – тип линии. Доступно три вариации: Lines, Bars, Steps. 

Symbols – позволяет выбрать представление линии на графике в виде точек, которые 

в свою очередь можно представить в виде кругов, прямоугольников, треугольников и 

других символов. 

Чекбокс Automatically generate Line Color позволяет настроить цвет символа. 

Работает аналогично настройки цвета линии. 

Fill Area – позволяет закрасить площадь под кривой на графике. Хорошо работает в 

связке с Line Type. Радиобаттон Always On – включает закрашивание. 

 

Рисунок 26. Настройка отображения линий на графике 

Если выбран режим закрашивания и Line Type – Lines, пространство под графиком 

будет закрашено сплошным цветом рисунок 27 (слева), Line Type – Bars (рисунок 27 по 

центру) заштрихует площадь по кривой вертикальными линиями. Line Type – Steps 

(рисунок 27 справа) закрасит пространство сплошным цветом и отобразит расстояние 

между точками в виде ступенек. 

 

Рисунок 27. Отображение типа линии на графике 

Во вкладке Chart Display можно настроить размеры шрифтов на графике и легенде, 

размеры символов и толщину линий. На рисунке 28 представлено отображения графика с 



рисунка 27 с увеличенным размером всех шрифтов, увеличенным размером символов и 

толщиной линий и с включенным отображением сетки графика (основные и 

вспомогательные линии). Легенда на графике выровнена по левому нижнему краю. Все 

настройки в данной вкладке интуитивно понятны. 

 

Рисунок 28. Настройка внешнего вида графика 

11. Для вычисления среднемассовых и других величин в постобработчике есть 

инструмент Таблица (Table). Вставляется в проект аналогично Chart.  

  

Рисунок 29. Вставка таблицы 

После успешного создания таблицы, откроется окно похожее на Excel. Хотя 

данный инструмент по внешнему виду напоминает таблицы Excel, Table в CFD Post 



не является Spreadsheet, т.е. в ней НЕВОЗМОЖНО настроить ссылки на другие 

ячейки. 

В каждой ячейке можно вводить формулы для расчёта интересующих величин. 

Формула набирается текстом или через контекстное меню, вызываемое правой клавишей 

мыши.  

Function → CFD Post содержит список функций, позволяющей определять длины, 

площади локаций, среднемассовые и средние значения по длине и по сечению/объёму.  

Например для расчёта расхода через центральную трубку, необходимо выбрать 

функцию massFlow. В ячейке, из которой было вызвано контекстное меню, появится 

текст «= massFlow()@». После знака @ необходимо указать сечение, через которое 

вычисляется расход.   

 

Рисунок 30. Список функций CFD Post для вычисления параметров поля: вычисление площади 

сечения (area), вычисление среднего по площади (areaAve), интеграл по площади (areaInt) и т.д. 

Function → CEL – математические функции. 

 

Рисунок 31. Список доступных математических функций 



Location – содержит список всех доступных линий, плоскостей, объёмов и границ. 

Здесь для продолжения вычисления расхода выбираем входное сечение холодного 

рабочего тела in_cold. 

 

 

Рисунок 32. Список доступных локаций, для вычисления значений поля 

При успешном вводе команды в ячейке появится рассчитываемая величина.  

 

Рисунок 33. Результат успешного вычисления расхода газа через холодный вход 

При расчёте среднемассовой величины необходимо выбрать функцию massFlowAve. 

В ячейке появится выражение вида «=massFlowAve()@». 

 

Рисунок 34. 

В скобочках () «=massFlowAve()@» необходимо указать переменную 

среднемассовое значение которой нужно определить: Variables → Temperature. 

После @ в «=massFlowAve()@» указывается сечение, через которое рассчитывается 

среднемассовое значение температуры: Plane 1. 



 

Рисунок 35. Успешное выполнение расчёта среднемассовой температуры в плоскости Plane 1 

Как видно в обоих примерах выше, любая вычисленная переменная имеет 

размерность, указанную в квадратных скобках. При вычислении сложных формул, 

содержащих знаки суммирования/вычитания следует следить за размерностью каждого 

члена выражения, и для констант обязательно после численного значения нужно 

добавлять соответствующую размерность. 

12. Иногда возникает необходимость рассчитать и визуализировать величины, 

которых нет в постобработчике. В этом случае можно создавать пользовательские 

переменные и выражения. Рассмотрим пример вычисления кинетической энергии потока 

2

2

U
. Для этого переключимся во вкладку Expression, через контекстное меню вызовем 

команду New Expression и введём название нового выражения – rhoUU.  

 

Рисунок 36. Создание переменной пользователя 

В опциях выражения в Definition с помощью контекстного меню запишем 

выражение для вычисления кинетической энергии потока: Density*Velosity*Velosity/2. 

Переменные в выражении также можно добавлять через контекстное меню. Далее 

переключаемся во вкладку Variables. 



 

Рисунок 37. Добавление пользовательского выражения 

Через контекстное меню создаем новую переменную, вводим её название – rUU2. 

Название не должно совпадать с уже существующим названием переменной или 

выражением. 

В опциях переменной выбираем Method – Expression. 

 

Рисунок 38. Создание пользовательской переменной 

В выпадающем меню Expression находим ранее созданное выражение rhoUU. 

Нажимаем Apply. Будет создана новая переменная, которую можно визуализировать в 

виде поля или отобразить её профиль.  



 

Рисунок 39. Выбор выражения для пользовательской переменной 

 

 

Рисунок 40. Результат успешного создания переменной пользователя 

Переменная пользователя по своим свойствам не отличается от стандартной 

переменной и для работы с ней доступны все инструменты: графики, таблицы, поля. 

Ниже представлены примеры работы с переменной пользователя. 



 

Рисунок 41. Пример отображения профиля новой переменной пользователя 

     

Рисунок 42. Пример вычисления среднемассового значения новой переменной через таблицы 

 

 

Рисунок 43. Пример отображения поля новой переменной 



13. Во многих задачах часто возникает необходимость построения большого количества 

локаций пользователя и определение большого количества параметров поля в созданных 

локациях. В CFD Post доступен инструмент, позволяющий автоматизировать построение 

однотипных объектов и формул. Это Command Editor. Данный инструмент вызывается 

по нажатию значка в панели инструментов, обведённого на рисунке 44 красной линией. 

Command Editor – это исполнитель текстовых команд пользователя. Команды 

пользователя можно превратить в скрипт с помощью какого-либо языка 

программирования или в Excel. Затем вставить все команды в Command Editor, который 

выполнит все команды за один раз. 

 

Рисунок 44. Command Editor 

Рассмотрим работу с данным инструментом на примере определения локального числа 

Нуссельта в геометрии следующего типа (рисунок 45). Исследуемая геометрия состоит 

из трёх частей: устройство, которое необходимо охладить, радиатор и трубки внутри 

радиатора, по которой течёт охлаждаемая жидкость. Устройство нагревается через 

верхнюю границу. Внешние стенки радиатора адиабатны. Через трубку течёт жидкость с 

фиксированным расходом и температурой. Требуется определить локальное значение 

числа Нуссельта по длине трубки. В данной постановке задачи не известен итоговый 

тепловой поток, который подводится к жидкости, неизвестна температура стенок трубки 

и неизвестна характерная температура потока. Определим все эти величины в 



постобработчике. Чтобы распределение числа Нуссельта по длине трубки не содержало 

разрывов, построим его в 150 сечениях. Длина трубки в данном случае равнялась 300 мм. 

 

 

Рисунок 45. Постановка задачи 

Процесс построения расчётной сетки и моделирование задачи, так же как и в первом 

случае пропустим. 

В первую очередь необходимо построить 150 сечений, проходящих только через трубку 

с охлаждающей жидкостью. По данным сечениям будет определяться характерная 

температура потока. Заметим в дереве постобработчика, что геометрия разбита на три 

части: part_2_copper (радиатор), part_2 part_1 (охлаждаемое устройство) и part_2 water 

(охлаждающая жидкость). 

 

Рисунок 46. Составные части геометрии 

Создадим вручную (как было показано в первом примере) плоскость. При создании 

плоскость выберем в Domains (рисунок 47) part_2 water. Тогда плоскость будет создана 

только в третьей части геометрии, содержащей жидкую фазу. Т.к. трубка в данном 

случае вытянута вдоль оси Z, то выберем метод построения плоскости XY Plane и введём 

координату Z. После нажатия кнопки Apply. Будет создана плоскость. 



 

Рисунок 47. Создание плоскость в домене, содержащем охлаждающую жидкость 

Теперь вызываем контекстное меню, щёлкнув правой кнопкой мыши на созданной 

плоскости. И выберем пункт Edit in Command Editor. Откроется Command Editor с 

перечнем всех свойств и команд, необходимых для построения плоскости (рисунок 49). 

 

Рисунок 48. Вызов Command Editor через контекстное меню плоскости 

 



 

 

PLANE: Plane1 

Apply Instancing Transform = On 

Apply Texture = Off 

Blend Texture = On 

Bound Radius = 0.5 [m] 

Colour = 0.75, 0.75, 0.75 

Colour Map = Default Colour Map 

Colour Mode = Constant 

Colour Scale = Linear 

Colour Variable Boundary Values = Hybrid 

Culling Mode = No Culling 

Direction 1 Bound = 1.0 [m] 

Direction 1 Orientation = 0 [degree] 

Direction 1 Points = 10 

Direction 2 Bound = 1.0 [m] 

Direction 2 Points = 10 

Domain List = part_2 water 

Draw Contours = Off 

Draw Faces = On 

Draw Lines = Off 

Instancing Transform = /DEFAULT INSTANCE 

TRANSFORM:Default Transform 

Invert Plane Bound = Off 

Lighting = true 

Line Colour = 0, 0, 0 

Line Colour Mode = Default 

Line Width = 1 

Normal = 1.0,0.0,0.0 

Number of Contours = 11 

Option = XY Plane 

Plane Bound = None 

Plane Type = Slice 

Point = 0.0, 0.0, 0.0 

Point 1 = 0.0, 0.0, 0.0 

Point 2 = 1.0, 0.0, 0.0 

Point 3 = 0.0, 1.0, 0.0 

Range = Global 

Render Edge Angle = 0 [degree] 

Specular Lighting = On 

Surface Drawing = Smooth Shading 

Texture Angle = 0 

Texture Direction = 0.0, 1.0, 0.0 

Texture Material = Metal 

Texture Position = 0.0, 0.0 

Texture Scale = 1.0 

Texture Type = Predefined 

Tile Texture = Off 

Transform Texture = Off 

Transparency = 0.0 

Visibility = On 

X = 0.0 [mm] 

Y = 0.0 [mm] 

Z = 0 [mm] 

END 

Рисунок 49. Команды для создания плоскости Plane 1. 

Взяв за основу данные команды, создадим список команд, позволяющий построить 

множество плоскостей. Для создания плоскости не нужны все команды и параметры, 

которые изначально отображаются в Command Editor. Достаточно нескольких строк. 



Удалив большинство строк и проверив работоспособность оставшихся команд создавать 

плоскость, получим следующий скрипт: 

_______________________________ 

 

PLANE: Plane 1 

Domain List = part_2 water 

Instancing Transform = /DEFAULT INSTANCE TRANSFORM:Default Transform 

Option = XY Plane 

X = 0.0 [mm] 

Y = 0.0 [mm] 

Z = 21 [mm] 

END 

_______________________________ 

Здесь Plane 1 – название плоскости (меняется от плоскости к плоскости). 

Domain List = part_2 water (строка во всех случаях остаётся без изменений) – говорит о 

том, что плоскость нужно создавать только в домене, содержащем жидкость.  

Instancing Transform = /DEFAULT INSTANCE TRANSFORM:Default Transform 

(строка во всех случаях остаётся без изменений) - задаёт трансформацию плоскости.  

Option = XY Plane (строка во всех случаях остаётся без изменений) – метод построения 

плоскости 

X = 0.0 [mm], Y = 0.0 [mm] (строки во всех случаях остаются без изменений) – 

координаты точки, принадлежащей плоскости. 

Z = 21 [mm] (изменяется) – третья координата плоскости, которая изменяется от 

плоскости к плоскости.  

END (без изменений) – завершает создание плоскости, начатое строкой PLANE. 

Изменяя название Plane 1 и координату Z в скрипте можно построить любое количество 

дополнительных плоскостей. 

Рассмотрим создание скрипта на примере работы со строками в Excel (рисунок 50). 

Названия создаваемых плоскостей будем задавать по типу Plane + порядковый номер. 

1. Создадим колонку с первой неизменяемой частью до порядкового номера (ячейка 

обозначенная на рисунке 50 номером 1).  

2. Рядом расположим колонку с порядковым номером плоскости (цифра 2 на 

рисунке).  

3. В следующей ячейке (номер 3) расположим весь текст до изменяемой координаты. 

Обязательно расставляем все пробелы и переносы строк (Alt+Enter).  

4. Добавляем колонку с координатой Z плоскости. 

5. Добавляем завершающую часть в следующую колонку. 



6. Для создания скрипта создадим в следующей ячейке функцию СЦЕПИТЬ и укажем 

в ней поочерёдно все ранее созданные ячейки. В результате в ячейке 6 должен 

получиться список команд для создания плоскости. 

7. Проверяем работоспособность скрипта. 

8. Растягиваем все «формулы» с первых ячеек вниз по колонкам. В результате в 

колонке 6 будет создано необходимое количество команд для создания всех 

плоскостей. 

9. Копируем колонку 6 и вставляем текст в Command Editor. Нажимаем кнопку 

Process. В результате будет создано нужное количество плоскостей. В дереве 

проекта в ветке User Location and Plots появятся все вновь созданные плоскости 

(рисунок 51). Отображение плоскостей отключено, чтобы визуализировать 

плоскость на экране, необходимо поставить галочку напротив нужной плоскости. 

 

Рисунок 50. Скрипт Excel для создания плоскостей в CFD Post 



 

Рисунок 51. Результат успешного создания плоскостей 

Аналогично создаются полилинии, огибающие боковую поверхность трубки. 

Необходимые команды для создания полилинии представлены ниже: 

_________________________________________ 

 

POLYLINE: Polyline 10 

Boundary List = wall part_2 copper part_2 water 

Location = /PLANE:Plane 10 

Option = Boundary Intersection 

END 

_________________________________________ 

 

Первая строка, аналогично с созданием плоскости, задаёт название полилинии. 

Полилиния будет создаваться методом пересечения границ расчётной области с 

созданными плоскостями (четвёртая строка Option = Boundary Intersection). 

Во второй строке указываются названия границ расчётной области, которые будут 

использоваться для создания полилинии. 

В третьей строке указывается название плоскости, с которой будет пересекаться граница, 

выбранная в предыдущей строке. 

Завершается создание полилинии также служебным словом END. 

Результат создания полилиний представлен на рисунке 52. 



 

Рисунок 52. Результат создания полилиний с использованием скрипта 

Теперь после успешного создания плоскостей и полилиний можно приступить к 

вычислению среднемассовой температуры потока, используя созданные плоскости, к 

температуре стенки и тепловому потоку на стенке (используя полилинии). 

Создадим по аналогии в Excel скрипт для вычисления указанных величин. Начнём с 

вычисления значения локального теплового потока. Для этого вычислим среднюю по 

длине величину теплового потока для каждой полилинии. Команда для вычисления 

теплового потока выглядит следующим образом: 

=lengthAve(Wall Heat Flux)@ Polyline1. 

Здесь до знака @ представлена неизменяемая часть, после него следует соответствующее 

название полилинии. 

Аналогично вычисляется локальная температура стенки: 

=lengthAve(Temperature)@Polyline1 

Среднемассовая температура потока в сечении: 

=massFlowAve(Temperature)@Plane1 

Локальное число Нуссельта 
w

q d
Nu

T T 



:  

=lengthAve(Wall Heat Flux)@Polyline1/(lengthAve(Temperature)@Polyline1-

massFlowAve(Temperature)@Plane1)*1e-2[m]/0.6[W/m/K] 



В данном случае гидравлический диаметр трубки d   равен 0.01 м. Коэффициент 

теплопроводности 0.6
Вт

м К
 


.  

Копируем все столбцы из Excel в Table. Получим локальное распределение числа 

Нуссельта по длине (столбец E рисунок 53). Теперь можно скопировать столбец со 

значениями Nu  и построить график распределения  Nu  по длине трубки (рисунок 54). 

 

Рисунок 53 Вычисление локального числа Нуссельта 

Анализ графика (рисунок 54) говорит о том, что с ростом расхода жидкости Nu  

увеличивается. Резкие скачки числа Нуссельта в первом и последнем сечении связаны с 

влиянием входа и выхода трубки. По аналогии обработки экспериментальных данных, 

вычисленные значения числа Нуссельта на входе и выходе из трубки, нужно исключить 

из анализа. 

 

Рисунок 54 Распределение локального числа Нуссельта по длине трубки в зависимости от расхода 

охлаждающей жидкости. 


